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Quick Start Guide 
 
 

The AQM monitor is securely packed to prevent damage in transit. Inside the 
cardboard box is a two piece aluminium skin with foam packing. It is 
recommended these be used again if the monitor is to be transported elsewhere. 
The AQM monitor must be assembled before operating. Power and any optional 
modules may need to be connected. Assembly of optional modules is described in 
Section 1. 
 
 

1. Unpack AQM and save packaging for transport later if required. 
 

2. Inspect AQM for any damage that may have occurred during transport. 
Contact Aeroqual if damage is found. 

 
3. Install power lead into power supply module. 

 
4. Fit mounting hardware if required 

 
5. Assemble peripheral sensors such as wind speed/direction sensors, PM 

inlet etc.  
 

6. Fit SD data card correctly into slot on control module (note it should be 
inserted upside down!) 

 
7. Turn on AQM by pressing blue power button on control module 

 
8. Set Up AQM  

a. Connect USB cable between AQM control module and computer. 
b. Launch AQM PC software.  
c. Click Setup --> Com port to select correct com port on PC. (Note the 

USB port on AQM is a RS232 adaptor with a unique Com Port 
number)  

d. Click File -> Search Monitor . The computer should automatically 
find the AQM and connect to it.   

e. Click Tools -> Update Real Time Clock  (this will synchronise the 
AQM clock with the computer date/time) 

 
9. Start data logging to confirm sensor communication and operation is 

correct.  
a. Click Data--> Table--> Real Time to launch real time data table. 
b. Click File --> Start Data logging. Data will start being displayed in 

Real Time Table. 
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Foreword 
 

Copyright Aeroqual Limited. All rights reserved. Reproduction, transfer, distribution or storage of part or all of 
the contents of this document in any form without the prior written permission of Aeroqual Limited is 
prohibited. 

“Aeroqual” and “Aeroqual Limited – Making the Invisible Visible” are registered trademarks of Aeroqual 
Limited. Other product and company names mentioned herein may also be trademarks or trade names. 

Aeroqual operates a policy of continuous development. Aeroqual reserves the right to make changes and 
improvements to any of the products described in this document without prior notice. 

Under no circumstances shall Aeroqual be responsible for any loss of data or income or any special, 
incidental, consequential or indirect damages howsoever caused. 

The contents of this document are provided "as is". Except as required by applicable law, no warranties of 
any kind, either express or implied, including, but not limited to, the implied warranties of merchantability and 
fitness for a particular purpose, are made in relation to the accuracy, reliability or contents of this document. 
Aeroqual reserves the right to revise this document or withdraw it at any time without prior notice. The 
availability of particular products may vary by region. Please check with the Aeroqual dealer nearest to you. 
 
 
© Aeroqual Limited 2010. All rights reserved. 
 
 

Statements of Compliance 
 

1. The Aeroqual AQM Monitor complies with EN 61000-6-1:2001 
2. The Aeroqual AQM Monitor complies with EN 61000-6-3:2001 
3. The Aeroqual AQM Monitor complies with Part 15 of the FCC Rules. Operation is subject to the 

following two conditions: (1) these devices may not cause harmful interference, and (2) these 
devices must accept any interference received, including interference that may cause undesired 
operation. 

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential installation. This equipment generates, uses 
and can radiate radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the interference by one or more of the 
following measures: 

— Reorient or relocate the receiving antenna. 
— Increase the separation between the equipment and receiver. 
— Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected. 
— Consult the dealer or an experienced radio/TV technician for help. 
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Warranty 
 
Thank you for purchasing this Aeroqual product. To get maximum use of the features of your new product we 
recommend that you follow a few simple steps: 

·  Read the guidelines for safe and efficient use. 
·  Read all the terms and conditions of your Aeroqual Warranty. 

o Save your original receipt. You will need it for warranty repair claims. Should your Aeroqual 
product need warranty service, you should return it to the dealer from whom it was 
purchased or contact Aeroqual.  

 

 
Our Warranty 
Aeroqual warrants this product to be free from defects in materials and workmanship for a period of 1 (one) 
year from the date of shipment from the factory.  Consumable items such as bearings, filters and gas 
scrubber media are excluded from this warranty.  
 
This warranty is expressly limited to the original owner who purchases the equipment directly from Aeroqual 
or from an authorized Aeroqual dealer.  
 
 
 

What We Will Do 
If, during the warranty period, this product fails to operate under normal use and service, due to improper 
materials or workmanship, Aeroqual subsidiaries, authorized distributors or authorized service partners will, at 
their option, either repair or replace the product in accordance with the terms and conditions stipulated herein. 

 
Conditions 
1. The warranty is valid only if the original receipt issued to the original purchaser by the dealer, specifying 

the date of purchase, is presented with the product to be repaired or replaced. Aeroqual reserves the 
right to refuse warranty service if this information has been removed or changed after the original 
purchase of the product from the dealer.  

 
2. If Aeroqual repairs or replaces the product, the repaired or replaced product shall be warranted for the 

remaining time of the original warranty period or for ninety (90) days from the date of repair, whichever 
is longer. Repair or replacement may be via functionally equivalent reconditioned units. Replaced faulty 
parts or components will become the property of Aeroqual.  

 
3. This warranty does not cover any failure of the product due to normal wear and tear, damage, misuse, 

including but not limited to use in any other than the normal and customary manner, in accordance with 
Aeroqual’s user guide for use, faulty installation, calibration and maintenance of the product, accident, 
modification or adjustment, events beyond human control, improper ventilation and damage resulting 
from liquid or corrosion.  

 
4. This warranty does not cover product failures due to repairs, modifications or improper service 

performed by a non-Aeroqual authorized service workshop or opening of the product by non-Aeroqual 
authorized persons. 

 
5. The warranty does not cover product failures which have been caused by use of non-Aeroqual original 

accessories. 
 
6. This warranty becomes void if a non-Aeroqual approved power supply is used.  
 
7. Tampering with any part of the product will void the warranty. 
 
8. Damage to the sensors can occur through exposure to certain sensor poisons such as silicones, 

tetraethyl lead, paints and adhesives.  Use of Aeroqual sensors in these environments containing these 
materials may (at the discretion of Aeroqual) void the warranty on the sensor head. Exposure to gas 
concentrations outside of the design range of a specific Aeroqual sensor head can adversely affect the 
calibration of that sensor head and will also void this warranty as it applies to the replacement of sensor 
heads. 

 
9. Aeroqual makes no other express warranties, whether written or oral, other than contained within this 

printed limited warranty. To the fullest extent allowable by law all warranties implied by law, including 
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without limitation the implied warranties of merchantability and fitness for a particular purpose, are 
expressly excluded, and in no event shall Aeroqual be liable for incidental or consequential damages of 
any nature whatsoever, however they arise, from the purchase or use of the product, and including but 
not limited to lost profits or business loss. 

 
10. Some countries restrict or do not allow the exclusion or limitation of incidental or consequential damage, 

or limitation of the duration of implied warranties, so the preceding limitations or exclusions may not 
apply to you. This warranty gives you specific legal rights, and you may also have other rights, which 
may vary from country to country. 

 
 
 
 

For Your Safety 
 
WARNING:    Do not switch the monitor on before reading the User Guide. 
Please follow the guidelines below. 
 
�  USE SENSIBLY 

Use only as per this user guide. 
 

�  USE AEROQUAL APPROVED SERVICE 
Only approved service personnel must work on this product.  
 

�  ACCESSORIES  
Use only approved accessories. Do not connect incompatible products. 
 

�  CONNECTING TO OTHER DEVICES 
When connecting to any other device, read the appropriate user guide for detailed safety 
instructions. Do not connect incompatible products. 
 

�  HAZARDOUS ENVIRONMENTS  
Do not use the monitor in or near volatile fuel or chemicals. 
 

�  HEALTH AND SAFETY IN THE WORKPLACE 
Aeroqual Monitors and Sensor Heads are used to monitor ambient gas concentrations. Aeroqual 
does not guarantee user safety.  In hazardous environments, an appropriate Health and Safety plan 
should be in place. 
 

 
 

. 
 

Technical Support 
 
 
Technical information, service and spare parts are available through your distributor. In addition, world wide 
technical support is available from Aeroqual Ltd.  
 
Please contact: 
 
Aeroqual Limited 
109 Valley Road, Mt Eden, Auckland 1024, New Zealand 
Phone: +64 9 623 3013 
Fax: +64 9 623 3012 
Email: technical@aeroqual.com 
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1.0 Description 
 
 
The Aeroqual AQM60 Environmental Station is a custom-built ambient air quality instrument which can be 
configured with up to six gas sensor modules as well as options such as a particle monitor, various weather 
sensors and communication modems. The configuration of the instrument supplied is determined by the 
sensor modules and communication options that were ordered. This modular design enables easy 
maintenance of sensors and components since the individual modules can be replaced minimising downtime. 
 
This manual describes the general use and operation of the AQM Environmental Monitor.  If you have 
ordered peripheral equipment such as radio or GSM modems, weather sensors or a custom control system, 
these will be described in detail in the OEM manual supplied with that equipment. 
 
The Product Information Sheet supplied at the front of the folder will specify the “as-built” monitors and the 
packing list of shipped items.   Please check that all the components have been supplied as per your order 
and contact your dealer or Aeroqual on email at: sales@aeroqual.com if any of the components are missing. 
 
The AQM consists of an enclosure typically containing a control module, power module, thermal management 
system, gas treatment module, a number of gas sensor modules, a RH/T sensor and associated cabling and 
plumbing (see below). The placement of individual modules will vary depending on the enclosure size and 
layout.  T 
 
 
 
 
 
 
 

Example of AQM Layout 
Note: your instrument may differ to that shown 

PM10 optical engine Gas Treatment 
Module with PTFE 
sample manifold 

Inlet filter 

Control Module with SD 
card logger 

Cooling fans 

Sensor Modules 

Internal Temperature 
Control Module 

exhaust 

PM10 flow 
module

RS232 to USB adapter 
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1.1 Internal Connections 
 
The general electrical and plumbing connections are described in the sections below. The actual cabling and 
tubing design will depend on the individual AQM configuration ordered.  All the sensor modules inside an 
AQM are linked on a RS485 communication bus.  Power is also supplied to each module via a two wire cable. 
 

1.1.1 Electrical 
 
 
 
RS485 Bus 
The two wire RS485 bus connections are made using 20 cm CAT5 cables between the sensor modules. The 
last module on the bus also has a blue termination dongle fitted. This should not be removed.  
 
 
12 VDC Power Bus 
All modules inside the AQM operate from the 12VDC power. The power is supplied by a daisy chain of black 
and red cables.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Grey Cat5 cable for the 
RS485 communication 
bus 

Red and black 2 wire 
power cable 

PTFE gas sample 
manifold 
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1.1.2 Pneumatics 
 
The air lines and connections are shown in the figure below for a six gas AQM. The sample gas passes into 
the Gas Treatment Module (GTM) and is distributed to the sensors via a PTFE manifold. Type A modules use 
the GTM pump to sample from the manifold while Type B (e.g. O3 and NO2) modules have an internal pump. 
The solenoid can switch between the air sample and air which has passed through an absorbent scrubber for 
baseline measurements. The sample inlet tubing is PFA tubing which is inert and smooth walled.  The module 
exhaust tubing is Tygon 3603 PVC tubing.  
 
The sample flow rate will be dependent on the number of gas sensor modules in the AQM. The common 
pump is rated at about 1 L L/min. The Type B module flow rates are documented in the performance report. 
All flows are controlled by critical orifices located within the sensor modules. 
 
 
 

Solenoid 

Pump 

Gas Module 
Type A 

Inlet 

Outlet 

Gas Module 
Type A 

Inlet 

Outlet 

Gas Module  
Type A 

Inlet 

Outlet 

Gas Module 
Type A  

Inlet 

Outlet 

Filter 5 um 

Zero Air  
Scrubber 

Check Valve 

1/4” Tube  Fitting 

Gas Module 
Type B  

Inlet 

Outlet 

Gas Module 
Type B  

Inlet 

Outlet 

Air in 

Gas Modules  
Type A = no internal 
pump 
Type B = internal 
pump 

Manifold 

Gas Treatment Module 
(exploded view) 
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1.2 Control Module 
 
The control module is the interface between the RS485 sensor bus and data communication links. It contains 
a display (optional), a SD data card which logs data, a RS232 serial connector for external communication, a 
bus connector for internal communication with the sensor modules and a cable connector for the Sensirion 
Humidity and Temperature sensor.  
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
Please note: 
The AQM60 is usually supplied with a RS232 to USB adapter fitted between the Control Module and an 
external USB socket fitted to the left hand side of the enclosure. This enables a computer to be connected to 
the AQM60 without needing the door open. This enables the user to perform a wide range of functions such 
as data logging and calibration (see Appendix A) using the supplied Aeroqual AQM PC software.   
 

RS232 serial 
communications 

SD card slot.  
 
Please note: the SD card is 
inserted face down 

Bus connector  

Power on/off Scrolling display 

12 VDC output for 
external devices 
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1.3 Power Module 
 
 
The Meanwell CLG-150-12A 150W 12V Single Output Class 2 with PFC Power Unit is mounted on the 
outside of the enclosure (depending on your power requirements you may have two). It has features including 
universal AC input (90-280VAC) and IP67/IP65 rating. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Please note: Some AQM configurations have the power module mounted outside the enclosure. This is 
to reduce heat input to the enclosure. This design is typically used for AQMs which are to be deployed in 
regions with high annual temperatures.   
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1.4 Gas Treatment Module 
 
The Gas Treatment Module controls the gas sampling. Inlet air is filtered through a 5 � m membrane filter and 
enters the Gas Treatment Module via either the sample or zero air ports. The air is then distributed via an 
aluminium manifold to the gas modules. A solenoid controls the air path which can be switched from the 
directly sampled ambient air to air which has passed through internal scrubbers (zero air) to check the 
baseline readings of the gas sensors. 
 

 
 

 
Specifications: 
  Solenoid:  12VDC, 3-way, Teflon 
  Pump:   BLDC diaphragm pump 
  Scrubber media:   1 x activated carbon + 1 x Hopcalite + 1 x Purafil Chemisorbent 
     cartridges.  
  Manifold:  PTFE  
  Fittings:   Luer 
  Flow rate:  0.2 to 1.0 LPM depending on sensor modules fitted. 
   
 
The media cartridges should be checked and replaced at least 3 monthly. To check the efficiency of 
scrubbing, allow the AQM to sample a low concentration gas mixture such as 20ppm of isobutylene or CO 
and check that the sensor readings drop to zero ppm within 30 minutes when the zero scrubber is turned on. 
If not, disconnect the scrubber and open to replace the media.  Note: the scrubber is designed to remove 
gases at concentrations found in ambient air. High concentrations of gases may break through the scrubber. 
 
 



AQM User Guide V5 Revision April2010  7 

1.5 Gas Modules 
 
An example of a gas module is show below.  All modules are mounted onto the base plate using 4 bolts. Inlet 
and outlet tubes are connected to the gas distribution manifold and exhaust respectively. Bus connection 
provides power and communications. 
 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Air flow rates are specific for gas sensor modules. O3 
and NO2 sensors have internal pumps and controlled 
flows. O3 sensor flow is modulated on/off. Other 
sensors use the common pump in the Gas Treatment 
Module and the flow is shared equally between them.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Sensor Inlet Flow / LPM 
O3 0.1-0.15  (modulated) 

NO2 0.06-0.07 
NOx 0.06-0.07 
CO 0.06-0.07 
SO2 0.12-0.15 
VOC 0.12-0.15 

NMHC 0.12-0.15 
PID 0.12-0.15 
CO2 0.06-0.07 

sample inlet 

sample exhaust 

12VDC power 
connectors 

RJ45 connectors for 
RS485 bus 
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Gas Sensor Module Specifications  
(Note: these are subject to change, please contact Aeroqual for latest performance data) 
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1.6 Humidity and Temperature Sensor  
 
The Humidity and Temperature Sensor is a Sensirion single chip device which contains a capacitive polymer 
sensing element for relative humidity and a band-gap temperature sensor. More detailed specifications are in 
the table below. The temperature and humidity sensor is housed in a connector located on the bottom of the 
enclosure. It is connected directly to the Control Module. 
 

Humidity  
Resolution 0.1 %RH 
Range 0 to 100 %RH 
Temperature  
Resolution 0.1 °C 
Range -40 to 120 °C 

 
 
 
 

1.7 Auxiliary Module 
 
Aeroqual manufactures a number of auxiliary modules that act as interfaces between third party sensors and 
the AQM60 communication bus.  The standard auxiliary module has 4 inputs: 
�  1 x freq counter logged as FREQ with range 0-32kHz   
�  2 x analog 0-5VDC inputs labelled and logged as AN1 and AN2  
�  1 x analog 0-450 mV logged as AN3.  
These analog inputs are digitised with 10 bit resolution.   
 

Standard Auxiliary Module with 4 analog inputs labe lled AN1, AN2, AN3 and 
FREQ. 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

12VDC output connector 

Analog input connector  

GND 12VDC 

AN3  
AN2  
AN1  

FREQ 

AGND 
AGND 
AGND 
AGND 

 
 
 
 
12VDC  power bus 
connectors 
 
 
 
 
 
 
 
 
Rs485 bus connectors 



AQM User Guide V5 Revision April2010  10 

1.8 Particle monitor  
 
The Particle Monitor uses a Met One instruments Inc. 80180 OEM Mass Detector which operates on the 
principle of light scatter from suspended particulates to provide a continuous real time measurement of 
airborne particulate. More detailed specifications are in the table below. The Particle Monitor is supplied with 
a 2.5 µm or 10 µm sharp cut cyclone to measure PM2.5 or PM10, respectively. 
 
Safety Conformity: This product, when properly installed and operated is considered a Class I laser product. 
Class I laser products are not considered to be hazardous. 
 
 

Parameter Specification 
Concentration 0 to 2000 µg/m3 
Sensitivity 1 µg/m3 
Sample Period 1 sec 
Accuracy +/- 8%  
Precision 3 ug/m3 (or 2% reading) 
Zero calibration Auto zeroing built in 
Span check Manual span check switch 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.8.1  Assembly 
 
1.  Assemble as shown in the below diagram. 
 

Parts List: (a) Inlet Tube/Heater Assembly, (b) Sharp Cut Cyclone, (c) TSP Assembly. 
 
 
 
 
 
Before: 

 
 
 
 
 
 
 
 
 
 
 
 

 
TSP Assembly 

Sharp Cut Cyclone 

Inlet Tube/Heater 
Assembly 

MD Engine 

Pump Assembly 

Electronics 

(a) (b) (c) 
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After: 

 
 
 
 
 
 
 
 
 
 
2. Remove protective cap from MD Engine. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Insert Inlet Tube/Heater Assembly through base mount and fix the three mounting screws. 
 
 
 
 
 
 
 
 
 
 
 
 
4. Connect power to Inlet Tube/Heater Assembly. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Protective 
Cap 

Base Mount 
Mounting 
Screws 
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1.8.2 Operation 
 
The Particle Monitor is designed to run with minimal servicing or adjustment. There is an inlet heater which 
automatically controls the sample air relative humidity to prevent particle swelling and fogging of the optics. 
Periodic checks of span and sample flow should be performed to identify any faults. 
 
Zero calibration 
There is a built-in auto zeroing feature which performs a zero measurement at 12 hour intervals. This is not 
user-adjustable.  
 
Span Check  
There is a manual span check which can be performed by switching the span switch to “ON”. This provides a 
simple test to insure that the system is functional at higher particle concentrations. The span check uses a 
solenoid controlled fibre optic switch. The value of the span check reading is quoted in the calibration 
certificate supplied with the unit (Fiber Span Reference Reading). However, the span check value is affected 
by heat and movement of the fiber thus it can only be used as detection of major component failures such as 
the laser, photo detector or lens.  If the reading is within about 20% of the reference reading it indicates no 
problem.  If it is outside this it should be sent back to Aeroqual for checking and recalibration. 
 
Flow check 
Attach a volumetric flow meter to the inlet tube (remove cyclone and TSP) and measure the inlet flow. The 
sample flow should be 2.0+/- 0.1 L/min for units which use a cyclone for size selection. If the sample flow is 
outside this range the flow module will need to be adjusted. See the service manual for instructions or contact 
Aeroqual Technical Support. 
 
 
 
 

 

1.9 Wind Speed/Direction Sensors 
 
 
 

1.9.1 Novalynx  
 
The Novalynx Model 200-WS-02B is a combination three cup anemometer 
and wind vane sensor.  For full details please visit the company website at www.novalynx.com 
 
 
Aeroqual provides a special interface unit which integrates the  Novalynx output into the AQM60 data. 
 
 

Anemometer   Wind Vane  
Turning radius 3” to centre of cup  Azimuth accuracy ± 3% 
Speed threshold 1.2 mph  Bearing type Bushing 
Transducer type Reed switch, magnet activated  Potentiometer gap 5° approx 
Speed Constant 1.25 mph = 1pps, 75mph=60hz  Distance constant 1.5’ 
Measurement range 0-99 mph (typical)  Damping ratio 0.4 
Accuracy 1mph or ± 3%  Vane threshold 1.2 mph 
   Measurement range 0-360 degrees azimuth 
   Time constant 2 sec 
   Turning radius 10 1/2” 

 

Assembly  
 
Feed the wind speed/direction sensor cable through the provided gable gland located on the bottom or rear 
side of the AQM enclosure.  
 
 
 

1 2 
3 4 5 

1 
2 3 4 

5 
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Operation 
The wind vane requires alignment of the “dead band” or potentiometer gap to either magnetic or True North 
(normally) to obtain valid measurements. True North is usually found by reading a magnetic compass and 
applying the correction for magnetic declination, where magnetic declination is the number of degrees 
between True North and Magnetic North. Alignment involves creating an imaginary line running through the 
wind sensor from North to South. When this line has been established, the mounting base of the sensor is 
rotated until the screw head in the base and the screw hole that is just above it in the sensor body both point 
toward North. 
 
 

1.9.2 Windsonic 

 
The Gill WindSonic wind sensor is a very robust, lightweight unit 
with no moving parts, outputting wind speed and direction. 
 
For full information on this sensor please read the manual on the 
company website www.gill.co.uk. 
 
Aeroqual provides a special interface unit which integrates the 
Windsonic output into the AQM60 data. 
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1.10 RF Modem 
 
The XStream 2.4 GHz RS-232/RS-485 radio modem provides long range, low 
power wireless serial communication with the AQM unit. You will typically 
require two modems to connect between the AQM and a computer. Units are 
DIP Switchable for RS-232, RS-422, and RS-485 support. Some specifications 
are given below, for more details see www.maxstream.net 
 
 
 

Outdoor RF line of sight range 5 km 
Transmit power output 50mW (17 dBm) 
Receiver sensitivity -105 dBm (@9,600 bps),-102 dBm (@19,200 bps) 
Spread spectrum FHSS (Frequency Hopping Spread Spectrum) 
RF data rate 10,000 bps (@9,600 bps) or 20,000 bps (@19,200 bps) 
Frequency range 2.4000 - 2.4835 GHz 

 
 
 
 

1.11 GSM Modem  
Aeroqual typically integrates the Fargo Maestro 100 Dual band GSM MODEM for remote data access.  This 
provides a serial link to the AQM from a computer via the GSM network. Note you will typically need two 
modems to establish a GSM link between computer and AQM. Please read the Fargo Maestro 100 manual 
for detailed instructions on configuration and use.  
 
Interface connections: 

·  SIM holder 
·  15 pin Sub-D connector (serial and audio connection) 
·  SMA antenna connector (50 ohm) 

 
Safety Precautions: 

·  The modem generates radio frequency (RF) power. When using the modem care must be taken on 
safety issues related to RF interference as well as regulations on RF equipment. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

·  The Modem requires a SIM card (Not supplied!) with a mobile phone account to operate. Please 
insert the SIM card before operating the modem. 

·  Once the GSM Modem is installed the AQM can be connected via the GSM link using the “Dial GSM” 
function in the AQM Software under the “Tools” menu. 

 
Configuration String 
 ATE0   (Turn off echo command) 
 AT+CBST = 0,0,0  (Set baud rate abd data transparent only) 
 AT+FCLASS = 0   (Set Operating mode = data mode) 
 AT+IPR=19200   (Set DTE/DCE baud rate = 19200) 
 ATS0=1            (Automatic answer after 1 ring) 
 AT&W          (Save all configurations) 
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1.12 Thermal Management Control System 
 
 
 
 
The AQM has a thermal management control system to maintain a stable 
internal temperature despite ambient temperature changes. The cooling 
system may be thermoelectric coolers or a compressor refrigeration unit.  
There is also an internal heater to maintain the temperature in cold external 
conditions. 
 

1.12.1 Thermoelectric Cooling System  
 
Thermoelectric units are used to transport heat from inside the box to the 
outside. A temperature controller is used to control the polarity and the 
power to the thermoelectric units so that they can heat or cool the box as 
required. The internal fans on the thermoelectric units run continuously, 
however the external fans only run when the thermoelectric coolers are 
powered. The AQM has been factory set to maintain its internal temperature 
at a setpoint defined in the instrument LOGBOOK. The internal temperature 
can be logged on the SD card if the sensor ITEMP is selected in the 
configuration window on the Aeroqual software. If the user suspects the the 
internal temperature is not stable due to insufficient control at the setpoint 
then the user should contact Aeroqual to receive instructions on changing 
the setpoint.  
 
Please note: The external housing should be positioned for maximum 
ventilation (do not cover) since waste heat needs to be lost to the ambient 
air via circulation. The external housing gets warm which is normal.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Picture showing thermoelectric 
units inside AQM60. The fans 
run continuously .  

External housing of 
thermoelectric units 

Picture of Thermal 
Management Controller. This 
contains the temperature 
sensor and relay control of 
the thermoelectric units. 
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1.12.2 Compressor based Refrigeration System 
 
 
 
 
 
 
 
The Compressor based Refrigeration system is mounted at the base of 
the AQM. It is a self contained system that provides cooling via the base 
on the AQM. The setpoint is controlled in a similar way to the 
thermoelectric system and the internal temperature can be logged if the  
ITEMP sensor is selected. 
 
 
 
 
 

The compressor system and inlet can be accessed by 
releasing the two clips on the side of the AQM and 
rotating the housing up. 

Refrigeration cooling system 
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Close-up photo of the refrigeration unit showing key components. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Power connection compressor sample tube inlet 
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Live Ground

Neutral

(A)(A)

(B)(B)

(B)

(C)(C)

1. 2.

 

2.0 Assembly, Commissioning and Installation  
 
 
 Please refer to the Commissioning and Installation guide for detailed instructions. 
 
 

2.1 Unpacking and Assembly 
 
1. Verify the serial number label on the documentation matches the serial label on the AQM (located on 
the inside surface of the AQM door). 
 
2.  Unpack the AQM monitor carefully. Please inspect the unit for damage that may have occurred 
during transport. Remove all internal shipping/packaging material from the AQM enclosure. 
 
3. The AQM monitor must be assembled before operating. Power and any optional modules need to be 
connected. Assembly of optional modules is described in Section 1. 
 
 

2.1.1 Power Connection 
 
Caution:  The high voltage mains supply must be wired by a certified electrician in compliance with local 
electrical regulations.  
 

1. Locate the 3 port junction box on the outside of the AQM cabinet. This may be located within the 
TMS external shroud or within the refrigeration unit (see section 1.12).  
Follow Figure 1: 

o unscrew from the enclosure at (A) 
o remove the three gland nuts.  (B) 
o insert a small flat bladed screwdriver to lever the retaining clips, on each side where 

indicated. (C)  
  

2. Wire a mains electrical cable as shown in Figure 2 to the terminal block provided (Live, Ground 
 and Neutral). 
 
3. Close the lid to the 3 port junction box and replace the three gland nuts. 
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2.2 Starting up for the first time 
 

After peripheral assembly and power connection has been made follow the steps below to get started. 
 

1. Install SD card into Control Module 
 

2. Connect USB cable between AQM and computer. The AQM will start up and begin datalogging 
immediately.   

 
3. To connect to the AQM and datalog to a computer 

�  Launch AQM PC software.  
�  Click Setup --> Com port to select correct com port on PC. (Note the USB port 

on AQM is a RS232 adaptor with a unique Com Port number)  
�  Click File -> Search Monitor . The computer should automatically find the AQM 

and connect to it.   
�  Click Tools -> Update Real Time Clock  (this will synchronise the AQM clock 

with the computer date/time) 
�  Click Data--> Table--> Real Time to launch real time data table. 
�  Click File --. Start Data logging. Data will start being displayed in Real Time 

Table. 
 

 
 
 

2.3 Operational Checks 
 
It is recommended that the AQM be checked before remote installation to confirm it is operating correctly. 
Please refer to the Commissioning and Installation guide for detailed instructions.  A simplified set of 
recommended checks is listed below: 
 
�  Run AQM overnight sampling outside air to allow it to warm up fully.  
�  Connect the AQM to a PC via the RS232 port and launch the AQM software. 
�  Select Data --> Table--> Real time table 
�  Start Data logging. 
�  If possible supply the AQM with humidified zero grade air. Otherwise let the AQM sample outside air.  
�  Sensor baseline check (see Section 5.0) 

o Select Tools --> turn on Zero Scrubber 
o Leave the AQM to log data for 30 minutes. 
o Select Tools ---> Turn off Zero Scrubber  
o If the sensors baseline values are close to zero (0 - sensor accuracy < reading < 0 + 

sensor accuracy) then the baselines are correct. If reading is outside this window then 
do a Zero Calibration.  

�  Sensor span check (see Section 5.0) 
o Challenge the AQM with a known concentration of gas in a humidified gas stream.  
o If the AQM reading is outside its specification then perform a span adjustment by 

modifying the gain factor for that sensor. 
�  Particle monitor (Section 1.8.2) 

o If the AQM is fitted with a particle monitor switch the fibre span to on and check the 
reading is close to that of the reference value.  

o Check the volumetric flow of the PM. 
�  Once satisfied with the AQM checks prepare it for transport and installation. 
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2.4 Transport 
 
Always transport the AQM in the cardboard box and two piece aluminium skins with foam packing 
provided to avoid breakages. Wrap all peripheral assemblies in their original packaging also. The AQM is 
a sensitive instrument and should be transported with care.  
 
 
 

2.5 Installation  
 
Please refer to the Commissioning and Installation guide for detailed instructions. Always transport the 
AQM in the packaging provided to avoid breakages. The AQM is a sensitive instrument and should be 
transported with care.  
 
�  The installation site should be selected where dust, vibration and weather extremes are minimized. 

The AQM is normally supplied with a thermal management system to maintain a stable internal 
temperature. If your system does not have this please contact Aeroqual for a recommendation on 
temperature control at your installation or control the external enclosure temperature to 25 +/-2 oC.  

 
�  Assemble peripheral components if supplied (see section 1). 
 
�  If a sample inlet extension is required to be fitted to the inlet fitting, then use inert tubing such as 

PTFE or PFA smooth wall tubing to minimize contamination and reaction of the sample line.  
Maximum recommended length is 5 m. 

 
�  Mount the AQM securely making sure it is located away from sources of interference gases and 

obstructions that may influence the response. A useful guide to the criteria for selecting a suitable 
site for ambient air monitoring is the EPA document 40 CFR 58, Appendix E. 

  
�  Connect power and turn on. The AQM will begin warming up and data logging. Optimum 

performance is normally achieved within 12 hours.  
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3.0 Instrument Maintenance 
 
 

Safety Requirements 
 
�  Replacement of any part should only be carried out by qualified personnel using only parts from the 

manufacturer 
 
�  Always disconnect power source before removing or replacing any components 
 
�  Surfaces marked with a "Caution, Hot Surface" and internationally recognised symbol may get hot and 

deliver burns. 
 
�  The Gas Treatment Module contains a Purafil Chemisorbant, Carulite 300 and Purakol media. This 

should be disposed of according to local regulations 
 
�  The 80180 Particle Monitor is a Class 1 laser product and is not considered dangerous if used correctly. 

It should not be powered up with the cover removed. 
 
 
 
 

3.1 Maintenance Schedule 
 
The following table outlines a typical periodic maintenance schedule for the AQM. This schedule is based on 
experience under normal operating conditions and may need to be modified to suit specific operating 
conditions. Calibration checks are normally performed at an interval consistent with regulatory policy or if 
none exists, consistent with the data use. 
 
 

Interval Item Procedure Section 
Weekly Inlet particulate filter 

Gas Sensor zero check 
Check/replace 
Perform 

1.1.2 
5.4 

Monthly Gas Sensor zero/span calibration 
Temp/RH sensor check 

Perform 
Perform 

5.0 
1.8 

3 Monthly Gas Treatment media 
Enclosure condition 

Check/replace 
Check/clean 

1.5 
 

6 Monthly Gas Sensor multi-point calibration Perform 5.0 
1 Year Leak Check Gas sensor plumbing Perform 3.2.2 
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3.2 Maintenance Procedures 
 

3.2.1 Removing and Replacing AQM Modules  
 
All modules are mounted onto the base plate with 4 screws.  
 
To remove a module, follow these steps:- 
 
1. Turn off AQM  
 
2.  Remove all air tubes,  plugs and cabling fitted to the particular module. 
 
3. Loosen the 4 screws holding the module to the base plate.  
 
4. Slide the module into the screw holder slots and remove module.  
 
5.  Cap the un-used tubing connections to avoid contamination with luer caps supplied with the unit. .  
 
  
To replace the sensor module, merely reverse this process, ensuring that the module fixes back onto the 
base plate securely and that the air tubes are replaced and firmly fitted to prevent any air leakage.    
 
 
 
 
 
 
 
 

3.2.2 Leak Test Procedures 
 
You will need a 0-2 LPM flowmeter, tubing, a 2 LPM diaphragm pump 
 
The Gas Treatment Module can be leaked tested by: 

·  Disconnect the gas sensor module lines from the manifold block. Block off all connectors with 
supplied luer caps except inlet. 

·  Attach a flow meter to the pump outlet and measure outlet flow. This should be within 10% of the 
value given in the factory performance report. If not, the pump will need to be replaced. 

·  Block off the inlets on the gas manifold and check that the pump outlet flow goes to 0 LPM. If not 
there are leaks in the module. Check and tighten connections. 

 
 
Sensor Modules 

·  O3 and NO2 modules can be leak tested by attaching a 0-0.5 LPM flow meter to the outlet and 
checking that the flow drops to 0 LPM when the inlet is blocked off. If not there is a leak. 
Disassemble the module and check the connections and tubing. If no obvious leaks are found the 
module should be reassembled and returned to the manufacturer.  

·  Other gas modules should be leak tested by disconnecting the inlet and outlet tubing. Connect a 
diaphragm pump to the outlet of the module and check the flow drops to 0 LPM when the inlet is 
blocked off.  Disassemble the module and check the connections and tubing. If no obvious leaks are 
found the module should be reassembled and returned to the manufacturer.  

 
 
 
 
 



AQM User Guide V5 Revision April2010  23 

 

4.0 Troubleshooting 
 
 
 

4.1 Troubleshooting Guide 
 
Symptom Possible Cause Fault isolation/Solution 
Gas sensor readings incorrect Insufficient warm up 

 
 
Incorrect zero calibration 
 
 
Incorrect span calibration 
 
Sensor module leaking 
 
Sensor pump failed 
 

Allow the sensors to fully warm up after power 
down.  This may require 2-3 hours or more. 
 
Repeat zero calibration with clean air.  Check 
media in Gas Treatment module.  
 
Perform span check.  
 
Check for leaks  
 
Measure flow. If pump has failed replace.  

NO2 sensor reading very high 
 
 
 

Incorrect zero calibration 
 
 
O3 Scrubber failed 

Repeat zero calibration with clean air.  Check 
media in Gas Treatment module.  
 
Challenge the NO2 sensor with 0.1 ppm of O3. If 
the response is large (>0.5 ppm) then the 
scrubber has failed. Replace. 
 
 

Gas Sensor readings noisy or 
unstable  
 
 
 

Leaks 
 
 
 
Particulate filter 
 

Leaks dilute the sample stream and can cause 
low span readings and incorrect zero readings. 
Perform a leak test.  
 
Replace if dirty. 
 

“NR” or “9999” in Data table 
(No response) 
 
 
 
 
 
Occasional NR or “9999” in Data 
Table 

No Response from Sensor module.  
Not connected correctly. 
 
Bus cable  
 
 
Computer too slow 
 
RF noise in environment.  
 
RS485 bus cable is faulty 
 

Check the electrical connector on the sensor 
module is firmly connected 
 
Check RS485 bus cable continuity 
 
 
 
 
Test with a faster computer.  
 
Try to reduce RF noise 
 
 
 

COMMUNICATION   
No communication over RS232 
 
 
 

RS232 cable disconnected 
 
Control Module Failed 

Reconnect cable 
 
Replace Control Module 

PC Data logging stopped AQM power blackout interrupted 
data logging.  
 
USB to serial hub not working 
 

Close and restart AQM software.  
 
 
Check USB connectors. Check the Moxa serial 
hub is present on the device hardware menu in 
the PC. If not reload driver software and re-
install.  
 

No data on SD card  
 
 
 
 
 

Card not correctly installed in slot.  
 
Data logging interval set too large. 
 
Data card module fault 
 

Turn off AQM and install card in slot correctly.  
 
Set logging interval in configuration to a lower 
interval. 
 
Send control module to factory for replacement 
module. 

RF communication fails RF modem incorrectly configured Follow modem manual instructions to 
reconfigure RF modem   
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4.2 Diagnostics  
 
The AQM has a number of sources for diagnostic information if a problem arises. These are described below: 
 
Event log  A large number of instrument events are logged on the event log file which is  
   located on the SD data card. This can be downloaded remotely (if a modem is  
   fitted) and in many cases can be used to determine whether a site visit is required.  
 
    
Event Code Examples Meaning 
  
 
NO2    :S.F. 2008/11/12 23:45  
 

Sensor failure 
NO2 module sensor failure on 12 Nov 
2008 at 23:45 

 
Power on: 2008/11/12 10:12  
 

AQM Power turned on at 10:12 am on 
12 November 2008 

 
Zero Cal at 2008/11/12 11:24 
 

Zero Calibration started at 11:24 on 
12 November 2008 

 
Config at 2008/11/12 13:12 
0x01,05,30,40,50,B0,F8,00,00,00,00,00,00,00,0
0,00,00  
 

AQM configuration saved at 1:12 pm 
on 12 November 2008 
Sensor codes listed 

0x30, ZF: 0.050, 2010/04/16  Sensor 0x30 zero offset changed to 
0.050 on 16 April 2010 
 

0x30, GF: 1.000, 2010/04/14 
 

Sensor 0x30 Gain Factor changed to 
1.000 on 14 April 2010 

 
 
 
 
 
 
 
 
Messages  This is located on the AQM PC software tool bar. If the AQM is connected to the  
   computer then event messages will be written to the Messages window in  
   real-time. 
 
 
Diagnostics  This is located in the AQM PC software. If the AQM is connected to the computer 
   then individual sensor modules can be interrogated to determine if there is a  
   problem not picked up by normal fault detection as well as fine tune the sensor  
   performance. Only qualified personnel should use this menu as incorrect use may 
   result in sensor malfunction. Please consult Aeroqual Technical Support to  
   understand how to use this feature. 
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5.0 Gas Module Calibration 
 

5.1 Introduction 
 
Zero and span adjustments on the  AQM60 V5 are performed by adjusting the OFFSET and GAIN values 
under the Calibration menu.  The equation that relates the OFFSET and GAIN  to the Gas reading is given 
below:  
 

Gas Reading = Gain x (Module Reading - OFFSET) 
 
 
All the Gas modules in the AQM can be calibrated in the unit by applying certified gas to the AQM inlet. 
 
�  All zero and span calibrations or checks should be performed with gas mixtures in a balance of 

air.   
 
�  Fluorocarbon (PTFE, FEP or PFA) tubing and fittings  should be used for all sample lines .  
 
�  The AQM is normally supplied with a thermal managem ent system to maintain a stable internal 

temperature.  Please calibrate the AQM with the doo r closed to enable the unit to stabilize at its 
correct temperature.  If no thermal management syst em is present then calibrate at normal 
laboratory temperature conditions (22 +/-2 oC) with the AQM door closed.  

 
 
 

�  Warm up the AQM for at least 12 hours before attempting a gas sensor calibration 
 
 

5.2 Nafion Humidifier 
 
The AQM gas sensors are slightly sensitive to changes in absolute humidity and it is recommended that the 
calibration be performed at a humidity level that is similar to that of the installation site.   
 
Span gas and zero air is typically dry (~0%RH) and  a piece of Nafion tubing  is supplied with the AQM which 
can be used to humidify the air delivered to the AQM during calibrations.  Two lengths of 1/4” Teflon tubes are 
supplied to enable connection to sample lines and the AQM inlet.   
 
Caution should be taken with the nafion since it can become contaminated with time and act to scrub gases 
such as ozone and NO2.  
 
The Nafion membrane is selectively permeable to water vapor (although some other compounds such as 
ammonia, alcohols, acetone, and acetic acid may also be transported across the membrane see 
www.permapure.com for further information) and the direction of transport is driven by the concentration 
gradient across the tubing wall. The Nafion will extract water vapor from the surrounding laboratory ambient 
air and transfer this into the dry span or zero gas source. The humidity can be further increased by positioning 
the nafion above a water bath to increase the humidity in the surrounding air. If possible always position the 
reference analyzer after the nafion so that any losses are accounted for. 
 
 

�  Make sure that the Nafion tubing does not 
introduce contaminants or reduce the span gas 
concentration in the span flow.  If in doubt do not use 
the Nafion . 
 
 
 
 
 
 

Nafion humidifier  
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5.3 Automatic Zero Check and Calibration  
The Gas Treatment Module contains a zero air scrubber which can be programmed to automatically turn on 
to periodically establish the zero of the instrument. The automatic zero setup is in the Setup menu under 
Operations. The auto zero check and calibration routines turn on the gas treatment module for 30 minutes . 
The interval between zero air checks can be set by the user between 1 and 255 hours.  
 
Please Note the difference between Zero Calibration and Zero Reading 
 
�  Zero Calibration  adjusts the OFFSET values. The change is logged in the EVENTLOG file on the SD 

card. 
�  Zero Reading  does not adjust the OFFSET value.  
 
 
 

5.4 Manual Zero calibration 

5.4.1 Using Gas Treatment Module 
You may use the zero air scrubber in the Gas Treatment Module to undertake a manual zero calibration. 
Before doing this you should check that the media are in good condition or if possible replace with fresh 
media.  
 

1. Turn on the zero scrubber manually by clicking on PC software,  Tools- >Turn On Zero Scrubber.  
2. Allow the AQM to sample until stable readings are obtained (about 30 - 60 minutes). 
3. Adjust the OFFSET values for each gas sensor via the Calibration --> Calibrate OFFSET-->enter 

password “password”--> select gas--->enter new OFFSET 
 

new OFFSET  =  old OFFSET  + AQM60 gas reading 
 
 
 

5.4.2 External Zero Air Source 
The AQM can be re-zeroed via the PC software using an external zero air source.  
 

1. Connect a source of zero air to the AQM through the sample port using ¼" Teflon tubing. Use a T 
fitting to ensure the AQM is sampling the gas flow at atmospheric pressure. The zero air should be 
at least 1.5 LPM (check there is excess flow at the exhaust of the T fitting). 

2. Allow the AQM to sample until stable readings are obtained (about 30-60 minutes). 
3. Adjust the OFFSET values for each gas sensor via the Calibration --> Calibrate  OFFSET-->enter 

password “password”--> select gas--->enter new OFFSET 
 

new OFFSET  =  old OFFSET  + AQM60 gas reading 
 

5.5 Span calibration  
The sensors are span calibrated by modifying the individual gain factors for each sensor. Note: a sensor zero 
point calibration should always be performed before undertaking a span calibration. 

5.5.1 Span gas  
 
Span gas mixtures should be certified and be in a balance of air unless the dilution is greater than 
50 times.  
 

�  DO NOT USE A SPAN GAS IN A BALANCE OF NITROGEN UNLESS DILUTION 
 IS GREATER THAN 50 TIMES WITH ZERO AIR. 
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Recommended span points for gas sensors are given in the table below. 
 
 

Recommended Span Points 
 

Gas Span Point / ppm 
O3 0.100 
NO2 0.100 
CO 5 
VOC (isobutylene) 5 
SO2 1 
NMHC (isobutylene) 5 
CO2 1000 
PID (isobutylene) 5 

 
 
Certified calibration standards that can be used with the AQM include certified gas bottles, diluent calibrators, 
or ozone calibrators.   
 
A three gas mixture that provides a convenient calibration standard for O3, NO2, CO and SO2 is described in 
the table below. Dilution by 100 with zero air and using a GPT calibrator will provide the required span points 
for NO2, CO, O3 and SO2 simultaneously  
 
 

Multi-gas mixture suitable for simultaneous calibra tion of NO2, CO and SO2 after 100 fold dilution 
 

Gas Concentration / ppm 
NO 10 
CO 500 
SO2 100 
Balance Nitrogen 
  

 
 
 
 

5.5.2 Span calibration procedure 
 
1. Perform zero calibration. 
2. Connect a source of span calibration gas to the AQM through the sample port (see the figure below 

for suggested setup).Use a T fitting to ensure the AQM is sampling the gas flow at atmospheric 
pressure. The span gas flow should be at least 1.5 LPM (check there is excess flow at the exhaust 
of the T fitting).   

3. Establish the correct concentration of gas, preferably verified using a reference analyzer connected 
to the same sample line. 

4. Wait until the reading is stable 
5. Adjust the AQM60 sensor gain factor to set the correct concentration reading.  
Calibration -->Calibrate Gain-->enter password “password”--> select gas--->enter new gain factor 

 
new Gain factor =  old Gain factor   x    Span gas concentration  /  AQM60 gas reading  

 
 
 
Please note: The change is logged in the EVENTLOG file on the SD card. 
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Schematic of Span Calibration Equipment  
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Appendix A AQM V5.x Software Instructions 
 

Description 

The AQM V5.x Software is designed to be a simple interface for communicating with the AQM monitor via a 
PC. It can be used to configure the AQM, initiate the zero calibration routine, modify gain factors, poll data 
and display the data in either table or graphical format. The software runs in Java VM1.5 (supplied with 
software) and the database is an open source HSQLDB Java database.  Data can be easily exported to a 
spreadsheet for manipulation. The software also incorporates a GSM modem connection which can be used 
to connect to and operate an AQM unit remotely. 
The software is compatible with AQM firmware versions 5.0 and higher only. 
 
Computer Requirements 
·  CD-ROM Drive 
·  RS232 port 
·  Windows OS version 2000 or later 
·  100 Mb of spare hard drive space 
·  recommended 256 Mb RAM 
·  recommended 1 GHz processor speed 

Setting up  

1. Install AQM CD into drive and extract the “Aeroqual AQM V5.x for Vista” or launch the AQM_5.x.exe 
software if you have earlier versions of Windows OS.  

 
2. Launch software 

�  Click Setup---> COM Port.  
�  Select correct COM port settings Port, 38400, 8, 1, N, N   
�  Click  OK 

 
 

Passwords 

The factory set passwords for the AQM are:   System password:  password 
      Diagnostic password:  george 
 
 
Screenshot 
 



AQM User Guide V5 Revision April2010  30 

 

Menu Descriptions 

File 
Search monitor   Searches for available AQM monitors. 
Start Data Logging  Starts data logging from the AQM monitor. 
Stop Data Logging   Stops data logging from the AQM monitor. 
Export Logged Data   Exports logged data from the AQM monitor. 
Import Files   Imports file (aql file). 
Download Files    Downloads files from the AQM; including daily files and event log  
Update sensor list  updates the sensor list on the database. 
Zip database   zips the database. 
Unzip database     Unzips the database (prompted by a warning message). (See below) 
Exit Ctrl X   Exits the AQM software. 
 
 

Setup 
Configuration   Configures AQM ID, Sensor Modules and gas concentration units  
    (System  password required “password”).  
Operations   Configures the Data logging interval and Auto Zero Function  
Test Connection   Tests the connection to the AQM monitor.  
COM Port     Sets the serial COM port for communicating with the AQM Monitor. (See 
    below) 
 

Data 
Graph --> Real Time  Graphs real time data from the AQM Monitor.  
Graph --> Logged Data  Graphs Logged data from the AQM Monitor.  
Graph --> Default Graph Style  Changes the graph style/settings.  
Table --> Real Time   Tabulates the real time data from the AQM monitor. (See below) 
Table --> Logged data   tabulates the logged data from the AQM monitor. (See below) 
 
 

Tools 
View Configuration  Views the configuration settings of the AQM monitor.  
Poll Data Ctrl D     Polls data from the AQM monitor (data will appear either in the real time 
    table or real time graph depending on which is open). 
Turn On Zero Scrubber  Turns on the zero scrubber. 
Turn Off Zero Scrubber   Turns off the zero scrubber. 
Change System Password  Changes the system password. 
Update Real Time Clock   Updates the real time clock to that of the computer  
    (prompted with a confirm message). 
Dial GSM Modem   Dials the GSM Modem (if applicable). 
Hang up GSM   Hangs up GSM line 
Reset Controller   Performs a software reset of the AQM60 Control Module 
 
 

Calibration 
View Gain and Offset  Displays table of the AQM60 Offset and Gain factors 
Calibrate Offset   Enables user to change the individual gas module Offset factors 
    (System  password required “password”). 
Calibrate Gain    Enables user to change the individual gas module Offset factors 
    (System  password required “password”). 
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Diagnostics 
 
Sensor Module Settings  Displays the sensor module settings (requires diagnostic password  
    “george”).  
    The parameters are exportable to a text file. 
 

�   Caution: incorrect modification of sensor module settings may cause 
irreversible damage. Do not change settings without contacting Aeroqual or a 
qualified service agent.  
 
 
Sensor Diagnostics View  Displays the sensor module diagnostic view (exportable to text file). 
 
 
 

Window 
Full Screen Display Toggles between full screen display and other open windows. (See below) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Help 
Help contents F1   Not currently functional 
About    Displays version information 
 
 
 

Additional Buttons 
Messages   Click on Messages on tool bar 
    Shows event messages when applicable (red when new message  
    occurs) 
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Appendix B Communication Protocol 
The AQM monitor information output is based on RS232 protocol. These command protocols are 
specified by Aeroqual Limited. Aeroqual reserves the right to change the protocol without notification. 
All rights reserved. 
 
Glossary: AQM - stands for Air Quality Monitor that include both outdoor and indoor Air Quality monitors. 
 
Version 5.0, This version is not back compatible with previous version, on 08/04/2010 
** Extended Protocol with AQM ID combined with data logging. 
** Added AQM ID in the property information. See command 10 for details. 
** Added zero calibration status polling command. 
** separate configurations to AQM configuration and operation settings. 
** Added sensor ppm to mg/m3 conversion factor setting command. 
** Removed span cal function 
** Added zero cal function without turning on zero scrubber 
 
The AQM controller master can only take max of 14 sensors, which include temperature, relative 
humidity sensors and Auxiliary modules as well.  
 
Section 1.  
 
General descriptions of communication commands. Command streams are binary,  
and all command, data use hexadecimal byte as representation. Comma and spaces are not  
applied for every command and reply data stream, they are just used for clearly 
specifying data stream: 
 
1. Sensor reading request command sent out from PC or other data receiver, its format is a 4 bytes stream: 
 
   MONITOR, AQM_ID, SENSOR_TYPE, CHECKSUM 
  
   * MONITOR - information request command header, its value is 0x55. 
   * AQM_ID - 1 byte, AQM ID its value 1-255. 
   * SENSOR_TYPE - gas concentration request command, please refer section 2 for details. 
   * CHECKSUM - the data stream's check sum - that makes the command stream total  
     bytes sum to be zero.  
 
   Example (To poll ozone reading): 0x55 0x01 0x30 0x7A 
 
 
2. Sensor reading request command reply or auto data report command data stream, 15 bytes: 
 
   SENSOR, AQM_ID, SENSOR_TYPE, DATA, SENSOR_STATUS, RB_TIMESTAMP, CHECKSUM 
  
   * SENSOR - 1 byte monitor reply data stream header, its value is 0xAA. 
   * AQM_ID - 1 byte of AMQ box ID, value is 1-255. 
   * SENSOR_TYPE - 1 byte gas type, its value will be same as the request command value, see section 2 for 
details. 
   * DATA - 4 bytes floating point data value. If the SENSOR_TYPE is gas sensor, 
  the value is concentration in ppm. If the value is 9999, this means the corresponding sensor didn't  
  give reading. Please refer to Section 2 for detail. 
   * SENSOR_STATUS - 1 byte sensor status indication, refer section 3 for details.   
   * RB_TIMESTAMP - 6 bytes timestamp, in the format of ss:mm:hh DD-MM-YY, each field is 1 byte, or all 
zero with no timestamp for SM50 basic controller. 
   * CHECKSUM - 1 byte the data stream's check sum - that makes the command stream total bytes sum be 
zero. 
 
 
 
3. AQM Monitor property configuration command, 4 bytes, followed by 19 bytes configuration data stream 
(since V4.0): 
 
   MONITOR, AQM_ID, SET_CONFIGURATION, CHECKSUM 
 
   * SET_CONFIGURATION - 1 byte command to configure AQM controller. 
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   MONITOR, AQM_ID, SENSOR_NUM, SENSOR_1, SENSOR_2, SENSOR_3, SENSOR_4, SENSOR_5, 
SENSOR_6, SENSOR_7, SENSOR_8,  
      SENSOR_9, SENSOR_10, SENSOR_11, SENSOR_12, SENSOR_13, SENSOR_14, 
AQM_STATUS, CHECKSUM 
 
   * AQM_ID - 1 byte value, indicate the AQM ID number, which range is 1 - 255. 
   * SENSOR_NUM - 1 byte, specify the valid numbers of sensor has been used by the AQM box. 
   * SENSOR_1, SENSOR_2, SENSOR_3, SENSOR_4, SENSOR_5, SENSOR_6, SENSOR_7, SENSOR_8,  
     SENSOR_9, SENSOR_10, SENSOR_11, SENSOR_12, SENSOR_13, SENSOR_14, - Specifies the 
sensor type has been 
     used for the AQM box. The value will be any of Sensor type value.  
   * AQM_STATUS - 1 byte, used specify AQM auto report data and auto zero calibration, see section 2 for 
details. 
 
   Example:  0x55 01 19 91 
   Followed by: 0x55 01 05 30 40 50 65 B0 00 00 00 00 00 00 00 00 00 03 CD 
 
3A. Configuring AQM property acknowledgement command, 4 bytes: 
 
   SENSOR, AQM_ID, SET_CONFIGURATION, CHECKSUM 
    
    
4. Request AQM Monitor property configuration command, 4 bytes, 
 
   MONITOR, AQM_ID, GET_CONFIGURATION, CHECKSUM 
 
   * GET_CONFIGURATION - 1 byte configuration request command, its value please see section 2. 
 
   Example:  0x55 0x01 0x18 0x92 
 
 
 
5. Request AQM Monitor configuration command reply, 19 bytes (since V4.0): 
 
   SENSOR, AQM_ID, SENSOR_NUM, SENSOR_1, SENSOR_2, SENSOR_3, SENSOR_4, SENSOR_5, 
SENSOR_6, SENSOR_7, SENSOR_8, 
      SENSOR_9, SENSOR_10, SENSOR_11, SENSOR_12, SENSOR_13, SENSOR_14, 
AQM_STATUS, CHECKSUM 
 
   * AQM_ID - 1 byte value, indicate the AQM ID number, which range is 1 - 255. 
   * SENSOR_NUM - 1 byte, specify the valid numbers of sensor has been used by the AQM box, max 
number is 14. 
   * SENSOR_1, SENSOR_2, SENSOR_3, SENSOR_4, SENSOR_5, SENSOR_6, SENSOR_7, SENSOR_8, 
SENSOR_9, SENSOR_10, SENSOR_11, SENSOR_12, SENSOR_13, SENSOR_14, - Specifies the sensor 
type has been 
     used for the AQM box. The value will be any of Sensor type value.  
   * AQM_STATUS - 1 byte, used specify AQM auto report data and auto zero calibration, see section 2 for 
details. 
 
 
6. Set monitor operation settings command 4 bytes followed by 8 bytes, 
    
   MONITOR, AQM_ID, SET_OPERATION, CHECKSUM 
 
   MONITOR, AQM_ID, SET_OPERATION, AUTO_REPORT_RATE, ZERO_CAL_INTERVAL, 
AUTO_ZERO_READ_FREQ, OPRATION_STATUS, CHECKSUM 
 
   * SET_OPERATION - 1 byte command, see section 2 for values. 
   * AUTO_REPORT_RATE - 1 byte, specify the auto data report rate in minutes maximum 255 minutes. It's 
only valid, when AQM_STATUS bit 0 is 1. 
   * ZERO_CAL_INTERVAL - 1 byte, specify the auto zero calibration interval in hours maximum 255 hours. 
It's only valid, when AQM_STATUS bit 1 is 1. 
   * AUTO_ZERO_READ_FREQ - 1 byte, specify the auto zero reading frequency in hours, max 255 hours. 
It's only valid, when AQM_STATUS bit 2 is 1. 
   * OPERATION_STATUS - 1 byte operation status, see section 2 for details. 
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6A. Acknowledge reply command of set operation, 4 bytes: 
 
    SENSOR, AQM_ID, SET_OPERATION, CHECKSUM 
       
7. Get monitor operation settings command 4 bytes: 
 
   MONITOR, AQM_ID, GET_OPERATION, CHECKSUM 
    
    
8. Reply command of get monitor operations, 8 bytes: 
 
   SENSOR, AQM_ID, GET_OPERATION, AUTO_REPORT_RATE, ZERO_CAL_INTERVAL, 
AUTO_ZERO_READ_FREQ, OPRATION_STATUS, CHECKSUM 
    
    
       
9. AQM Monitor information request command, 4 bytes: 
 
   MONITOR, AQM_ID, AQM_INFO, CHECKSUM 
 
   Example: 0x55 0x01 0xFB 0xAF 
 
   * AQM_INFO - 1 byte AQM information request command. 
 
 
 
10. AQM monitor information reply command, 16 bytes: 
 
   SENSOR, AQM_ID, AQM_INFO, VERSION, NAME, RTC, CHECKSUM 
 
   * AQM_ID - 1 byte value, indicate the AQM ID number, which range is 1 - 255. 
   * AQM_INFO - 1 byte sensor information request command, see section 2 for its value. 
   * VERSION - 1 byte, its unsigned value divided by 10 gives the AQM box version number. 
   * NAME - 5 bytes, the monitor name ASCII code (AQM60/AQM10/IQM60). 
   * RTC - 6 bytes, the monitors Real Time Clock (each field is one byte), ss:mm:hh DD/MM/YY, the year is 
since 1900+YY 
   ** User could use this command to test communications. 
 
 
 
 
11. AQM Monitor zero calibration starts command 4 bytes: 
 
   MONITOR, AQM_ID, ZERO_CAL_WITH_SCRUBBER, CHECKSUM 
 
   * ZERO_CAL_WITH_SCRUBBER - 1 byte command to start the zero calibration for all gas sensor 
modules. 
 
   Example 0x55 0x01, 0x12 0x98 
 
11A. Acknowledge reply command of Zero calibration, 4 bytes  
 
   SENSOR, AQM_ID, ZERO_CAL_WITH_SCRUBBER, CHECKSUM 
    
 
12. Turn on Zero Scrubber command, 4 bytes: 
 
   MONITOR, AQM_ID, ZERO_SCRUBBER_ON, CHECKSUM 
 
   * ZERO_SCRUBER_ON - 1 byte command to turn on zero scrubber. 
 
   Example 0x55 0x01 0x14 0x96 
 
12A.Acknowledge reply command of Zero scrubber turn on acknowledge reply command, 4 bytes: 
 
   SENSOR, AQM_ID, ZERO_SCRUBBER_ON, CHECKSUM 
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13. Turn off Zero Scrubber command, 4 bytes: 
 
   MONITOR, AQM_ID, ZERO_SCRUBBER_OFF, CHECKSUM 
 
   * ZERO_SCRUBER_OFF - 1 byte command to turn off zero scrubber. 
 
   Example 0x55 0x01 0x15 0x95 
 
13A.Acknowledge reply command of Zero scrubber turn off, 4 bytes: 
 
   SENSOR, AQM_ID, ZERO_SCRUBBER_OFF, CHECKSUM 
    
 
14. Zero calibration command without turning on zero scrubber, 4 bytes command: 
 
   MONITOR, AQM_ID, ZERO_CAL_WITHOUT_SCRUBBER, CHECKSUM 
 
   * AQM_ID - 1 byte AMQ identification, 1-255. 
   * ZERO_CAL_WITHOUT_SCRUBBER - 1 byte command to perform the zero calibration without turning on 
zero scrubber. 
   * SENSOR_TYPE - 1 byte sensor type code. 
   * CALIBRATION_POINT - 4 bytes floating point data, specified the sensor span calibration point 
 
   Example: 0x55 01 13 97 
        
   
14A. Acknowledge reply command of zero calibration without zero scrubber turning on, 4 bytes: 
 
   SENSOR, AQM_ID, ZERO_CAL_WITHOUT_SCRUBBER, CHECKSUM 
 
 
 
15. Get all sensor module gain factor values command, 4 bytes: 
 
   MONITOR, AQM_ID, GET_GAIN_FACTORS, CHECKSUM 
 
   * GET_GAIN_FACTORS - 1 byte command to get the AQM all configured sensor gain factors. 
 
   Example: 0x55 01 16 94 
 
 
 
16. Replied gain value for all configured sensors, total 74 bytes: 
 
   SENSOR, AQM_ID, GET_GAIN_FACTORS, SENSOR_GAIN_VALUE, SENSOR_GAIN_VALUE, 
SENSOR_GAIN_VALUE,  
   SENSOR_GAIN_VALUE, SENSOR_GAIN_VALUE, SENSOR_GAIN_VALUE, SENSOR_GAIN_VALUE, 
SENSOR_GAIN_VALUE,  
   SENSOR_GAIN_VALUE, SENSOR_GAIN_VALUE, SENSOR_GAIN_VALUE, SENSOR_GAIN_VALUE, 
SENSOR_GAIN_VALUE,  
   SENSOR_GAIN_VALUE, CHECKSUM 
 
   * SENSOR_SPAN_VALUE - 5 bytes each, consist of 1 byte SENSOR_TYPE code, 4 bytes floating point 
gain factor value. 
     Example: 0x30 00 00 80 3F, this is O3 Low sensor with span factor of 1.0 
 
 
17. Set gain value command, 4 bytes command followed by 9 bytes span calibration value details: 
 
   MONITOR, AQM_ID, SET_GAIN_FACTOR, CHECKSUM 
   MONITOR, AQM_ID, SET_GAIN_FACTOR, SENSOR_TYPE, GAIN_VALUE, CHECKSUM 
 
   * SET_GAIN_FACTOR - 1 byte command to change the gain value 
   * GAIN_VALUE - 4 bytes floating point data, specified the sensor span calibration point 
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   Example: 0x55 01 17 93 
     0x55 01 17 30 00 00 80 3F A4 
   
     * Set gain factor 1.0 for O3 sensor 
 
 
17A. Acknowledge reply command of setting gain value,  4 bytes: 
 
   SENSOR, AQM_ID, SET_GAIN_FACTOR, CHECKSUM 
 
 
18. Get all sensor module offset factor values command, 4 bytes: 
 
   MONITOR, AQM_ID, GET_OFFSET_FACTOR, CHECKSUM 
 
   * GET_OFFSET_FACTOR - 1 byte command to get the AQM all configured sensor offset factors. 
 
   Example: 0x55 01 01 A9 
 
 
 
19. Replied offset value for all configured sensors, total 74 bytes: 
 
   SENSOR, AQM_ID, GET_OFFSET_FACTOR, SENSOR_OFFSET_VALUE, SENSOR_OFFSET_VALUE, 
SENSOR_OFFSET_VALUE,  
   SENSOR_OFFSET_VALUE, SENSOR_OFFSET_VALUE, SENSOR_OFFSET_VALUE, 
SENSOR_OFFSET_VALUE, SENSOR_OFFSET_VALUE,  
   SENSOR_OFFSET_VALUE, SENSOR_OFFSET_VALUE, SENSOR_OFFSET_VALUE, 
SENSOR_OFFSET_VALUE, SENSOR_OFFSET_VALUE,  
   SENSOR_OFFSET_VALUE, CHECKSUM 
 
   * SENSOR_OFFSET_VALUE - 5 bytes each, consist of 1 byte SENSOR_TYPE code, 4 bytes floating point 
offset factor value. 
     Example: 0x30 00 00 00 00, this is O3 sensor with offset factor of 0.0 
 
 
20. Set offset value command, 4 bytes command followed by 9 bytes sensor offset value details: 
 
   MONITOR, AQM_ID, SET_OFFSET_FACTOR, CHECKSUM 
   MONITOR, AQM_ID, SET_OFFSET_FACTOR, SENSOR_TYPE, OFFSET_VALUE, CHECKSUM 
 
   * SET_OFFSET_FACTOR - 1 byte command to change the offset value 
   * OFFSET_VALUE - 4 bytes floating point data, specified the sensor offset at zero 
 
    
20A. Acknowledge reply command of setting offset value,  4 bytes: 
 
   SENSOR, AQM_ID, SET_OFFSET_FACTOR, CHECKSUM 
 
 
 
21. Set sensor names for data logging and monitors with displays.  
    This is 4 bytes command, followed with 115 bytes with sensor code and name ASCII. 
 
   MONITOR, AQM_ID, SET_SENSOR_NAMES, CHECKSUM 
 
   MONITOR, AQM_ID, SENSOR_1, NAME_1, SENSOR_2, NAME_2, SENSOR_3, NAME_3, SENSOR_4, 
NAME_4, SENSOR_5, NAME_5,  
      SENSOR_6, NAME_6, SENSOR_7, NAME_7, SENSOR_8, NAME_8, SENSOR_9, NAME_9, 
SENSOR_10, NAME_10,  
      SENSOR_11, NAME_11, SENSOR_12, NAME_12, SENSOR_13, NAME_13, SENSOR_14, NAME_14, 
CHECKSUM 
 
   * SET_SENSOR_NAMES - 1 byte command to set sensor names, refer section 2 for its value. 
   * SENSOR_1 ~ SENSOR_14 - 1 byte Specified sensor type has been used for the monitor. 
   * NAME_1 ~ NAME_14 - are the names of sensors. They are in ASCII format 7 char each, less than 7 USE 
blank char instead. 
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21A. Acknowledge reply command for setting sensor names, 4 bytes: 
 
   SENSOR, AQM_ID, SET_SENSOR_NAMES, CHECKSUM 
 
22. Set concentration valid decimal numbers for monitors with display. 
    This is 4 bytes command, followed with 31 bytes sensor code and decimal numbers. 
 
   MONITOR, AQM_ID, SET_DECIMAL_NUMS, CHECKSUM 
 
   MONITOR, AQM_ID, SENSOR_1, DECIMAL_1, SENSOR_2, DECIMAL_2, SENSOR_3, DECIMAL_3, 
SENSOR_4, DECIMAL_4, SENSOR_5, DECIMAL_5,  
      SENSOR_6, DECIMAL_6, SENSOR_7, DECIMAL_7, SENSOR_8, DECIMAL_8, SENSOR_9, 
DECIMAL_9, SENSOR_10, DECIMAL_10,  
      SENSOR_11, DECIMAL_11, SENSOR_12, DECIMAL_12, SENSOR_13, DECIMAL_13, SENSOR_14, 
DECIMAL_14, CHECKSUM 
 
   * SET_DECIMAL_NUMS - 1 byte command to set valid fraction digits for all the sensor readings. 
   * SENSOR_1 ~ SENSOR_14, - 1 byte each, sensor type code has been used for the monitor. 
   * DECIMAL_1 ~ DECIMAL_14 - 1 byte each, which is the values of decimal numbers for the sensor valid 
reading. 
 
22A. Acknowledge reply command for setting valid decimal numbers, 4 bytes: 
 
   SENSOR, AQM_ID, SET_DECIMAL_NUMS, CHECKSUM 
 
 
23. AQM Monitor zero calibration status information request command, 4 bytes: 
 
   MONITOR, AQM_ID, ZERO_INFO, CHECKSUM 
 
   Example: 0x55 0x01 0xFC 0xAE 
 
   * ZERO_INFO - 1 byte zero calibration status information request command. 
 
 
 
24. AQM monitor zero calibration status information reply command, 4 bytes: 
 
   SENSOR, AQM_ID, ZERO_INFO, ZERO_STATUS, CHECKSUM 
 
   * ZERO_INFO - 1 byte zero calibration status,  
   * ZERO_STATUS- 1 byte = 0x00, zero calibration finished or not zero calibration state,  
     else the zero calibration was processing. 
 
 
25. AQM Monitor real time clock update command, 4 bytes, followed by 10 bytes real time data: 
 
   MONITOR, AQM_ID, SET_RTC, CHECKSUM 
    
   MONITOR, SET_RTC, RTC, CHECKSUM 
 
   * SET_RTC - 1 byte update Real Time Clock command. 
   * RTC - 7 bytes Real Time clock, ss:mm:hh dd/MM/YY WD(Week Day)  
 
25A. Acknowledge reply command of updating real time clock, 4 bytes: 
 
 
   SENSOR, AQM_ID, SET_RTC, CHECKSUM 
 
 
26.Get all logged file name list from SD card command, 4 bytes: 
 
   MONITOR, AQM_ID, GET_FILE_NAME_LIST, CHECKSUM 
 
   * GET_FILE_NAME_LIST - command to get file name list. 
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27.Reply of the above command is 20 bytes stream. The command requester could get many of this reply. 
   Each of them is a individual file. Until 3 seconds time up, without any reply: 
    
   SENSOR, AQM_ID, GET_FILE_NAME_LIST, FILE_NAME, FILE_SIZE, CHECKSUM 
 
   *FIlE_NAME - 12 bytes ASCII code of the full file name. 
   *FILE_SIZE - 4 bytes long integer value of the file size. 
 
28 Download a logged file in SD card via serial port, the command is 4 bytes: 
 
   MONITOR, AQM_ID, DOWNLOAD_A_FILE, CHECKSUM 
 
   * DOWNLOAD_A_FILE - 1 byte command 
 
   Followed by 15 bytes stream with file name: 
    
   MONITOR, DOWNLOAD_A_FILE, FILE_NAME, CHECKSUM 
    
   * FILE_NAME - 12 bytes ASCII code of a full file name. 
 
 
   Reply data stream is ASCII coded data record, with tab delimited (\t) and new line ends, 
   receiver just simply look for line ends (\n): 
 
   Example file data: 
 
   AQM ID: 255\n 
   Year Month Date Time Sensor1 Sensor2 ... SensorX Inlet\n  *File header with 
tab delimited 
   09 01 18 10:12:00 0.026 10.6 ... 2.8 S\n  *Date, time and 
readings with tab delimited 
   09 01 18 10:14:00 0.028 9.8 ... 2.6 S\n  *Date, time and 
readings with tab delimited 
    
    
   * Sensor1 ~ SensorX - sensor name ASCII with tab delimited. 
   * 10:12:00 - 8 bytes time ASCII, hour:minutes:seconds 
   * 0.26, 10.6 - 8 bytes decimal value in ASCII 
   * S - 1 byte inlet state, S for Sample, Z for Zero air scrubber on 
 
29 Delete a file in SD card command, 4 bytes followed by 15 bytes with file name: 
 
   MONITOR, AQM_ID, DELETE_A_FILE, CHECKSUM 
    
   * DELETE_A_FILE - 1 byte command to delete a file in data logging card. 
    
   Followed by 16 bytes stream with file name: 
       
   MONITOR, AQM_ID, DELETE_A_FILE, FILE_NAME, CHECKSUM 
       
   * FILE_NAME - 12 bytes ASCII code of a full file name. 
 
29A. Acknowledge reply command to confirm the file delete operation was successful. 
    
   SENSOR, AQM_ID, DELETE_A_FILE, CHECKSUM 
 
 
30. Set sensor conversion factors for display gas reading in unit of mg/m3.  
    This is 4 bytes command, followed by 73 bytes: 
 
   MONITOR, AQM_ID, SET_CONVERSION_FACTOR, CHECKSUM 
 
   MONITOR, AQM_ID, SENSOR_1, FACTOR_1, SENSOR_2, FACTOR_2, SENSOR_3, FACTOR_3, 
SENSOR_4, FACTOR_4, SENSOR_5, FACTOR_5,  
      SENSOR_6, FACTOR_6, SENSOR_7, FACTOR_7, SENSOR_8, FACTOR_8, SENSOR_9, FACTOR_9, 
SENSOR_10, FACTOR_10,  
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      SENSOR_11, FACTOR_11, SENSOR_12, FACTOR_12, SENSOR_13, FACTOR_13, SENSOR_14, 
FACTOR_14, CHECKSUM 
 
   * SET_CONVERSION_FACTOR - 1 byte command to set sensor conversion factors, refer section 2 for its 
value. 
   * SENSOR_1 ~ SENSOR_14 - 1 byte Specified sensor type has been used for the monitor. 
   * FACTOR_1 ~ FACTOR_14 - 4 bytes floating point values. 
 
30A. Acknowledge reply command for setting sensor conversion factors, 4 bytes: 
 
   SENSOR, AQM_ID, SET_CONVERSION_FACTOR, CHECKSUM 
    
   * SET_CONVERSION_FACTOR - 1 byte command to set sensor conversion factors, refer section 2 for its 
value. 
    
31. Get sensor module version information command 4 bytes: 
 
   MONITOR, AQM_ID, GET_SENSOR_VERSION, SENSOR_CODE 
    
   * GET_SESNOR_VERSION - 1 byte command to get sensor module version info, refer section 2 for its 
value. 
   * SENSOR_CODE - 1 byte specific sensor code 
    
32. Sensor module version info reply command 15 bytes: 
 
   SENSOR, AQM_ID, GET_SENSOR_VERSION, SENSOR_CODE, VERSION_NUM, DISP_TYPE, 
NAME_LENGTH, NAME_ASCII, CHECKSUM 
    
   * GET_SESNOR_VERSION - 1 byte command to get sensor module version info, refer section 2 for its 
value. 
   * SENSOR_CODE - 1 byte specific sensor code 
   * VERSION_NUM - 1 byte sensor version number scaled up by 10, so its real number is 
VERSION_NUM/10. 
   * NAME_LENGTH - 1 byte specifies the sensor's name valid ASCII code length. 
   * NAME_ASCII - 7 byes ASCII code of sensor name, its valid length is specified by NAME_LENGTH. 
 
 
33*. Download a specific sensor calibration parameters command, 4 bytes .  
 
   MONITOR, AQM_ID, SENSOR_PARAM_DOWNLOAD, SENSOR_TYPE 
 
34*. Download param reply command. The command will get the sensor's all parameters. The total reply 
stream length is 50 bytes. 
 
   SENSOR, HTR, OFFSET, TEMPRESET, TIMERESET, TEMPREAD, TIMEREAD, H0, H1,  H2,  PWML, 
PWMH, CYCLENUM, CHECKSUM 
  
   * SENSOR_PARAM_DOWNLOAD - 1 byte command, its value = 0x08 
   * SENSOR_TYPE - 1 byte sensor code. 
   * HTR, OFFSET, TEMPRESET, TIMERESET, TEMPREAD, TIMEREAD, H0, H1,  H2,  PWML, PWMH, 
CYCLENUM 
     - are 4 bytes floating point value,  
    
35*. AQM sensor module parameters upload command. The command consist of two data streams 
     one upload invoking command 4 bytes, then followed by a parameters stream which is 50 bytes. 
 
   Command: MONITOR, AQM_ID, SENSOR_PARAM_UPLOAD, SENSOR_TYPE 
   Parameters: MONITOR, HTR, OFFSET, TEMPRESET, TIMERESET, TEMPREAD, TIMEREAD, H0, H1,  
H2,  PWML, PWMH, CYCLENUM, CHECKSUM 
 
   * SENSOR_PARAM_UPLOAD - 1 byte command, its value = 0x09 
    
35a*. Acknowledge reply command 4 bytes: 
 
   SENSOR, AQM_ID, SENSOR_PARAM_UPLOAD, CHECKSUM 
 
   * The reply is used for confirming the sensor parameter upload was successful 
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36*  Reset controller command, 4 bytes: 
 
   MONITOR, AQM_ID, RESET, CHECKSUM 
    
   * RESET - 1 byte command to reset controller, please refer section 2 for its value 
    
36a* Acknowledge reply command of reset controller, 4 bytes: 
 
   SENSOR, AQM_ID, RESET, CHECKSUM 
       
   * RESET - 1 byte command to reset controller, please refer section 2 for its value 
 
Section 2.  
 
Protocol command values: 
 
MONITOR   = 0x55    header command used for receiver command 
SENSOR    = 0xAA    header command used for monitor reply 
 
GET_CONFIGURATION   = 0x08    Request configure of AQM box command 
SET_CONFIGURATION = 0x09    Configure AQM box command 
 
GET_OPERATION  = 0x06    Set AQM box operation command 
SET_OPERATION  = 0x07    Get AQM box operation command 
 
GET_FILE_NAME_LIST = 0x0A    Get all file name list command  
DOWNLOAD_A_FILE  = 0x0B    Download a file from SD card command  
DELETE_A_FILE  = 0x0C    Delete a file in SD card command 
 
ZERO_CAL_WITH_SCRUBBER = 0x12    Zero calibration command with scrubber on 
ZERO_CAL_WITHOUT_SCRUBBER = 0x13    zero calibration without turning on zero scrubber 
ZERO_SCRUBBER_ON = 0x14    Turn on zero scrubber 
ZERO_SCRUBBER_OFF = 0x15    Turn off zero scrubber 
GET_GAIN_FACTORS = 0x16    request span calibration values  
SET_GAIN_FACTOR  = 0x17    Set sensor gain factor  
SENSOR_PARAM_DOWNLOAD = 0x18   Download sensor module parameters command 
SENSOR_PARAM_UPLOAD = 0x19   Upload sensor module parameters command 
 
GET_OFFSET_FACTOR = 0x01   Get all sensor reading offset correction factor 
SET_OFFSET_FACTOR = 0x02    Set one sensor offset value 
 
SET_SENSOR_NAMES = 0x1C    Set sensor names   
SET_DECIMAL_NUMS = 0x1D    Set sensor concentration display decimal points number  
SET_RTC   = 0x1E    Set AQM monitor Real Time Clock.   
SET_CONVERSION_FACTOR = 0xFA    Set sensor ppm to mg/m3 conversion factors. 
AQM_INFO  = 0xFB    AQM monitor information request command. 
ZERO_INFO  = 0xFC    Zero calibration status request command 
RESET   = 0xFD   reset controller command 
 
SENSOR_TYPE  These values defined a sensor type respectively. Some type of sensors can be  
   extended up to 4 more subtypes, such as, NO2 can extend to 0x51, 0x52, 0x53. 
   Some of can one only extend 1 subtype for reserving. However, every extended 
   sensor type need a special program. Therefore the value can be any of the  
   followings and their extensions (Aeroqual may update the sensor coding): 
   = 0x30    //O3 concentration data request command  
   = 0x31    //O3B another ozone module data request command - can extend 
   = 0x40    //CO concentration data request command   - can extend 
   = 0x50    //NO2 concentration data request command   - can extend 
   = 0x55    //NOx concentration request command,  
   = 0x60    //VOC concentration data request command   - can extend 
   = 0x61    //NMHC concentration data request command 
   = 0x62    //VOC LOW concentration data request command  
   = 0x65    //C6H6 BENZ concentration data request command   - can extend 
   = 0x70    //H2S concentration data request command   - can extend 
   = 0x80    //PERC concentration data request command   - can extend 
   = 0x82    //CH4 methane concentration data request command   - can extend 
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   = 0x90    //NH3 concentration data request command   - can extend 
   = 0x91    //NH3 LOW (0-100) concentration data request command. 
   = 0xA0    //HC12 concentration data request command   - can extend 
    
   = 0xA2    //IPA concentration data request command   - can extend 
   = 0xA4    //H2O2 concentration data request command   - can extend 
   = 0xA6    //ETAC concentration data request command   - can extend 
   = 0xA8    //PROP concentration data request command   - can extend 
   = 0xAB    //H2 concentration data request command   - can extend 
 
   = 0xB0    //SO2 concentration data request command   - can extend 
   = 0xB5    //CO2 concentration data request command   - can extend 
   = 0xBA    //PID gas sensor concentration data request command 
   = 0xBB    Reserved gas sensor data request command   - can extend 1 
   ...       ... 
   = 0xBF    Reserved gas sensor data request command   - can extend 1 
 
   // from here are used for other sensor types - not gas concentration types 
   = 0xC0    Reserved sensor data request command   - can extend 1 
   = 0xC2    Reserved sensor data request command   - can extend 1 
   = 0xC4    Reserved sensor data request command   - can extend 1 
   = 0xC6    Reserved sensor data request command   - can extend 1 
   = 0xC8    Reserved sensor data request command   - can extend 1 
 
   = 0xCA    //Noise meter SPL data request command 
   = 0xCB    //Noise meter SLeq data request command 
   = 0xCC    //Noise meter LLeq data request command 
 
   = 0xCD   //PM ug/m3 particle monitor no particle size specified 
    
   = 0xCE    //8PC0.3 particle counter data request command 
   = 0xCF    //8PC0.5 particle counter data request command 
   = 0xD0    //8PC0.7 particle counter data request command 
   = 0xD1    //8PC1.0 partials counter data request command 
   = 0xD2    //8PC2.0 particle counter data request command 
   = 0xD3    //8PC3.0 particle counter data request command 
   = 0xD4    //8PC5.0 particle counter data request command 
   = 0xD5    //8PC10 particle counter data request command 
   = 0xD6    //PC0.3 particle counter data request command 
   = 0xD7    //PC2.5 particle counter data request command 
   = 0xD8    //PM2.5 ug/m3, Particle monitor reading request command  
   = 0xD9    //PM10 ug/m3, Particle monitor reading request command  
    
   = 0xDA    //WS - Wind Speed, data request command, sin wave signal input(max 
32kHz), result is wind speed in meter/second or can be frequency in Hz(require special program).  
   = 0xDB    //WD - Wind Direction, data request command, analogue input 0-5V, 
result is degree angles relative to zero point or voltage (require special program).   
   = 0xDC    //AN1, 0-5V analogue input data request command,   
   = 0xDD    //AN2, 0-5V analogue input data request command,   
   = 0xDE    //AN3, 0-450mV analogue input data request command  
   = 0xDF    //Freq, 0-32kHz pulse input data request command,  
   = 0xE0    //ITEMP, AQM internal temp data request command 
   = 0xE1    //FLOW, air flow rate data request command 
   = 0xE2    //IBOX, IQM internal temp data request command 
   = 0xE3    //RAIN, Rain gauges meter data request command 
   = 0xE4 - 0xEF    Reserved data request command  
   ..................... 
   = 0xF0 - 0xF5 are reserved command space 
   = 0xF6    Temperature data request command   - can extend 1 
   = 0xF8    Relative humidity data request command   - can extend 1 
   from 0xFA are reserved for other commands. 
      
RESERVED  1 byte reserved not been used for information transfer, can be 0x00 
RESERVED_2  2 bytes reserved 
RESERVED_3  3 bytes reserved 
RESERVED_4  4 bytes reserved 
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CHECKSUM  a data stream's check sum - that makes the command stream  
                        total bytes sum is zero. 
  
  
SENSOR_STATUS  * 8 bits (b7b6b5b4b3b2b1b0) monitor and sensor status information 
  
 SensorStatus    * b0 = 1 sensor failure 
   * b0 = 0 sensor working fine  
  
 Reserved        * b1 reserved no meaning at all   
  
 PumpStatus * b2 = 1 pump failed  (This bit function only apply for O3 sensors 
with pump) 
   * b2 = 0 pump working well 
  
 NO2_Scrubber * b3 = 1 NO2 scrubber temperature too low, otherwise, works well (This bit only 
related with NO2 sensor). 
  
 ZeroScrubber    * b4 = 1 zero air scrubber turned on, otherwise, its off 
  
 Reserved * b5 reserved no meaning at all 
 Reserved        * b6 reserved no meaning at all 
 Reserved        * b7 reserved no meaning at all 
  
AQM_STATUS  * 8 bits (b7b6b5b4b3b2b1b0) monitor configuration status information 
 
   * b0 = 0, means the AQM gas reading unit is ppm 
   * b0 = 1, means the AQM gas reading unit is mg/m3 
   * b1 ~ b7 reserved 
 
OPERATION_STATUS * 8 bits (b7b6b5b4b3b2b1b0) monitor operation status information 
 
   * b0 = 0, means the AQM will only report data by polling individual sensor 
   * b0 = 1, means the AQM will auto report all sensor concentration at specified rate. 
 
   * b1 = 0, means the AQM will only do zero calibration by user command 
   * b1 = 1, means the AQM will auto do zero calibration at specified 
ZERO_CAL_INTERVAL. 
 
   * b2 = 0, means the AQM will not do auto zero readings. 
   * b2 = 1, means the AQM will do auto zero readings at specified 
AUTO_ZERO_READ_FREQ 
     time intervals. The zero reading time is fixed 15 minutes long. 
    
   * b3 ~ b7 reserved 
 
Section 3.  
 
Data value format representation: 
 
The floating point data values use standard IEEE754 32 bits floating point little ending 
representation, like DATA field. 
  
Section 4.  
 
  Data transfer mechanism 
 
  1. Due to the monitor main chips feature, 2 byte int and 4 bytes float data send sequence are 
     low byte first, high byte last.  
 
  2. For regular data report:  
  
  Once the monitor power on and after warming up (1 minute), it will regularly report measured result 
  to RS232 serial port by default.  
  
Section 5. RS232 communication port settings: 
 



AQM User Guide V5 Revision April2010  43 

 Baud rate: 38400 
 Data bits: 8 
 Stop bits: 1 
 Parity:  none 
 Flow control: none 
  
Section 6. EventLog.aql file specification: 
 
  1. Once AQM turned on the date and time will be logged in the file. 
  2. Sensor status will be logged in the event log file, when a sensor failure indicated. 
  3. When request a sensor readings and there is no reply, the sensor will be logged in the file 
     to indicate the sensor module might be stop working. 
  4. Sensor module with pump, which failed status will be logged in the file. 
  5. If there is NO2 sensor module, the Ozone scrubber working status will be logged in the file. 
  6 . Gain factor changes are logged 
  7. Offset changes are logged. 


